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1. Introduction to Kernel for Macintosh

Welcome to the user manual for Kernel for Macintosh, the most powerful and professional data recovery 
software that helps you to recover Mac data from formatted, damaged, or corrupted volumes and even 
from initialized disks. This user manual comprises step by step guidelines on using Kernel for Macintosh. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for Macintosh. We suggest that first time 
users should read this user manual completely and carefully before proceeding to use the software. 
However, if you are an experienced user, you can use the table of contents to find out information 
pertaining to the tasks that you need to perform by using Kernel for Macintosh.  

You can use the table of contents to navigate through different sections of this user manual. The table of 
contents lists all the sections that are contained in this user manual in chronological order. The user 
manual comprises the following sections: 

 Introduction

 Getting Started

 Software Interface

 Recovering corrupt volumes

 Full Version

 Support

 Troubleshooting

 Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

Mac: Macintosh 

MS: Microsoft 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 



© KernelApps Private Limited

1.2  About Kernel for Macintosh 

Kernel for Macintosh is data recovery software which recovers Mac operating system data. The reason for 
data loss could be: 

 Bad Sector in the Disk

 Disk Initialization

 Master Directory Block or Volume Header Corruption

 Catalog File Corruption

 Extents or Extents Overflow file corruption

 Catalog File's node corruption

 Partition Table Corruption

Kernel for Macintosh recovers data from deleted, formatted, damaged, or corrupted volumes and even 
from initialized Mac hard disks. It recovers data from crashed Mac drives of eMac, iMac, iBook, iPod 
instantly. 

1.3 Salient Features 

Salient features of Kernel for Macintosh include: 

 Recovers partition if partition are deleted or formatted

 Recovery from Lost or Missing Mac folders

 Support for all versions of Macintosh (HFS, HFS+)

 User friendly graphical user interface

 Recognizes and preserves long file names when recovering Mac files & folders

 Full support for IDE, EIDE, SCSI and SATA drives

 Free demo to experience the capabilities of the tool before purchasing it

1.4 Who Should Use this Software? 

The capability of Kernel for Macintosh to recover Mac operating system corrupt, damaged, deleted data 
makes it appropriate for use by professionals, individuals, organizations who have Macintosh operating 
system installed on their system. The corruption could have happen to Mac data due to bad sector in disk, 
disk initialization, catalog file corruption, partition table corruption, etc. Kernel for Macintosh proves useful 
in these cases of Mac data corruption. 
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2. Getting Started

Now that you have understood the features and potential of Kernel for Macintosh, you are ready to get a 
hand on experience of the software. To start recovering Mac data, you will first need to download and 
install this software.  

It is strongly recommended that before installing Kernel for Macintosh, you should go through the 
installation pre-requisites for the software to ensure that your computer is appropriately configured to run 
the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for Macintosh can be broadly classified into 
two major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor

 Minimum 64MB RAM (128 MB recommended)

 10MB for Software installation

 Disk Space - Enough space to save the recovered files

 You should have at-least 10 MB of free disk space if you want to repair and save a 
10 MB Mac data. 

2.1.2 Software Requirements: 

The software requirements for installing the software can further be grouped into two categories– 
Operating system requirements and Macintosh file system version requirements. The requirements are as 
follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems: 

 Windows Vista

 Windows XP

 Windows 2003

 Windows 2000
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 Windows NT

 Windows ME

 Windows 98

 Windows 95

2.1.2.2 Macintosh File System Version Requirements 

Supported Macintosh File System Version: 

 HFS Apple Mac OS X

 HFS+ Apple Mac OS X

 HFS Apple Mac OS 9.x and higher

 HFS+ Apple Mac OS 9.x and higher

2.2 Downloading Kernel for Macintosh for the First Time 

After checking your computer with the prescribed system requirements for Kernel for Macintosh, you can 
download and install the software on your computer. You can buy the full version of the software from any 

one of our authorized resellers – Element5, Asknet and 2CO. 

If you want to try using Kernel for Macintosh before buying it, you can download the evaluation version 
from the following link: 

https://www.nucleustechnologies.com/Macintosh-Data-Recovery-Software.html

 You can recover Mac data files by using the evaluation version of Kernel for 
Macintosh; however, the recovered file will not be saved until you purchase full 
version of the software. 

2.3 Install Kernel for Macintosh 

After downloading the installer file for Kernel for Macintosh, you can install the software by running the file. 
To install Kernel for Macintosh: 

1. Double-click the Kernel for Macintosh installer. Follow the on-screen instructions.

The Setup Installation Complete screen will be displayed. 

2. Click Finish to launch the software.

2.4 Start Kernel for Macintosh 

To start Kernel for Macintosh: 

https://www.nucleustechnologies.com/Download-Macintosh-Data-Recovery-Software.php
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Click the Start  All Programs Kernel for Macintosh 

Alternatively, you can launch Kernel for Macintosh by double-clicking the shortcut icon available on the 
Desktop and Quick Launch icon. 

2.5 Uninstall Kernel for Macintosh 

You may need to uninstall and re-install Kernel for Macintosh. To uninstall Kernel for Macintosh: 

1. Click the Start  All Programs Kernel for Macintosh  Uninstall Kernel for Macintosh

A warning message will be displayed. 

2. Click ‘Yes’ to uninstall Kernel for Macintosh.

 Before proceeding to uninstall Kernel for Macintosh, you must ensure that the 
software is not running. 

You can alternatively uninstall Kernel for Macintosh from the Control Panel by performing the following 
steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon.

2. Select Kernel for Macintosh and click Remove.

A warning message will be displayed. 

3. Click ‘Yes’ to uninstall Kernel for Macintosh.
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3. Software Interface

Now that Kernel for Macintosh has been installed on your computer, you can start using the software after 
getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for Macintosh comprises four main menus – Recovery, View, Tools and Help. 

3.1.1 Recovery Menu 

The Recovery menu comprises five menu items. 

Figure 3.1: Recovery Menu 

Menu items in the Recovery menu: 

Field Name Field Description 

Recover 
Selected 

Select to recover the selected files in right pane of the window 

Recover All Select to recover all files in the right pane of the window 

Save Recovery 
Snapshot 

Select to save the scan information about the file(s) and folder(s) 
that have been found in the recovery process 

Load Recovery 
Snapshot 

Select to load the scanned information that has been used using 
Save Recovery Snapshot 

Exit Select to exit from the software 
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3.1.2 View Menu 

The View menu comprises three menu items. 

Figure 3.2: View Menu 

Menu items in the View menu: 

Field Name Field Description 

Icons Select to view the file(s) and folder(s) in Windows 
standard small icon view style 

List Select to view the file(s) and folder(s) in Windows 
standard list view style 

Details Select to get the details like File Size, Creation product 
name, and Type along with the name of the file or folder 

3.1.3 Tools Menu 

The Tools menu comprises five menu items. 

Figure 3.3: Tools Menu 

Menu items in the Tools menu: 
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Field Name Field Description 

Find Files Select for searching a particular file or file type in the data 
found 

File Filters Select to add filters to the files recovered 

Settings Select to configure the settings of the software 

Drive Information Select to get the information about the file system being 
recovered 

Live Update Select to update the current software with the available 
version in the Nucleus server 

3.1.4 Help Menu 

The Help menu comprises three menu items. 

Figure 3.4: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Contents Select to get the Help Guide for the software 

Buy Online Select to open the page on the Internet to buy the 
software online 

About Select to get the version and other information related to 
the software 
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3.2 Tool-bar 

The tool-bar in Kernel for Macintosh is displayed below the menu-bar. The tool-bar provides a convenient 
and user-friendly method to perform certain actions that can also be performed by using the menu-bar. 
Read the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

Recover 
Selected 

Select to recover the selected files in the right 
pane of the window 

Recover All Select to recover all files in the right pane of the 
window 

Save Recovery 
Snapshot 

Select to save the scan information about the 
file(s) and folder(s) 

Load Recovery 
Snapshot 

Select to load the recovery summary or snapshot 
saved last time 

Find Files Select to search for particular files in the current 
recovery session 

Settings Select to configure the various options to control 
over the whole recovery process 
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Live Update Select to update the current software with the 
available version in the Nucleus server 

3.3 Buttons Used 

Apart from the standard options available in the menu-bar and the tool-bar, three buttons– Next, Back, 
Stop buttons are displayed on the main window. 

Click to proceed with the recovery process 

Click to go back to the previous window 

Click to stop the searching process 
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4. Recovering Corrupt Volumes

Now that you have complete familiarity of the user interface of Kernel for Macintosh, you are ready to 
recover corrupt volumes of Macintosh. To recover volumes: 

1. Launch Kernel for Macintosh. As soon the software is launched, it scans all the physical disks attached
to your system and displays them.

Figure 4.1: Main window showing all physical disks 

2. Select the device from where you want to recover the corrupt volume.

3. Select the Volume Identify Options from the main window of the software either Use Partition Table
or Search Partition.

 Use Partition Table - This option is the default option to recover corrupt volumes.

 Search Partition - This option will search your partition if you don't get your partition using
"Use Partition Table".

4.1 Use Partition Table 
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To go by Use Partition Table option, perform the following: 

1. First three steps are same as step 1, 2, 3 of Recovering Corrupt Volumes.

2. Select the Use Partition Table option.

3. Click Next button to proceed. Kernel will start mounting the volumes.

Figure 4.2: Scanning Process 

4. As the scanning gets complete, the software displays the recovered files and folders of the selected
device.
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Figure 4.3: Recovered Data 

5. Select the files and folders which you want to save from the right pane of the window and copy using
Recover Selected button in the tool-bar. Save at the appropriate location.

 You can also right click and save all file or selected files at appropriate location. 

4.2 Search Partition 

If you don’t get your partition or you have missed the partition then you can use Search Partition option to 
search your missing partitions. To go by Search Partition option, perform the following: 

1. First three steps are same as step 1, 2, 3 of Recovering Corrupt Volumes.

2. Select the Search Partition option from Volume Identify Option.

3. Edit the Start Sector and End Sector to search and click Next button to proceed with the next step of
searching process. Then after the searching process, it will display all the partitions found during
searching process.
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Figure 4.4: Using Search Partition option 

4. Select the found partition from which you want to recover data and click Next button for recovery
process.

5. As the scanning process gets complete, software displays the recovered files and folders of the
selected partition.

6. Save the recovered data by selecting the same from the right pane of window and copy using Recover
Selected button in the tool-bar. Save at the appropriate location.

 You can also right click and save all file or selected files at appropriate location. 
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5. File Search from Found Data

5.1 File Search 

With thousands of files and directories to view, finding a particular file in a directory tree can be difficult. 
The Search option makes finding the files much easier. This option is modeled after some of the most 
popular Windows programs, making it very easy to use.  

If you know the name or part of the name of the file(s) or folder(s), then follow this step: 

 Click Tools menu   Find Files or click Search button from the Toolbar. 

 A new window appears which asks for the string to search.

String could be *, *.TXT, AB*.*, ABC.txt etc. 

5.2 File Filters 

The Filter feature allows you to filter the files you are interested in by viewing in the directory tree display. 
There can be a situation when the total found data contains too many file(s) but you only want to recover 
and see only some application specific data, like all the text file(s). In that situation consider the following: 

 Click Tools menu   File Filters.

 Screen pop-ups which ask for Filter. You can add or remove the filters available accordingly.

  The software will filter only the file(s) that you want to recover and it will hide rest of 
the file(s). 
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6. Full Version

Although you can use Kernel for Macintosh evaluation version for free and experience the capabilities of 
the software, there are certain features that are not available in the evaluation version. 

6.1 Requirement of Full Version 

By using the evaluation version of Kernel for Macintosh, you can recover the corrupted or deleted data, 
files and folders. However, you cannot save the recovered data. 

You will need to buy the full version of the software to save all the recovered data at the desired location. 

6.2 Purchasing Full Version 

You can buy the full version of Kernel for Macintosh from any one of our authorized resellers – Element5, 
Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for Macintosh and activation details of the 
software. 
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7. Support

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for Macintosh. The software comes with an embedded help manual that can be accessed 
by clicking HelpContents in the menu-bar. You can also press the F1 key on the keyboard 
of your computer to access the embedded help of Kernel for Macintosh. 

We have live support wherein you can chat with our software experts at 

https://www.nucleustechnologies.com/supportcenter/

To talk on phone with our software experts call: 

Help line:  

+91-9818725861

1-866-348-7872 (Toll Free for USA/CANADA)

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

https://www.nucleustechnologies.com/Online-Helps.html
https://www.nucleustechnologies.com/Animated_Demo_Mac.html
https://www.nucleustechnologies.com/supportcenter/
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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8. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for Macintosh. 

8.1 Common Issues 

Why does Kernel for Macintosh have limitations in evaluation copy? 

The free evaluation version of Kernel for Macintosh is intended to enable you to experience the 
capabilities of the software. You will need to buy the software to save the recovered data. 

8.2 Frequently Asked Questions 

Can I install the software on the same device from which I want to recover deleted file(s)? 

First of all, do not install Kernel Macintosh Data Recovery Software on the Bad Device. Remember the 
golden rule of data recovery: Never change anything on the Bad Device! 

Even do not install Kernel Macintosh - Data Recovery Software on the same drive from which you want 
to recover deleted file(s) because there is a possibility of overwritten of data. 

How to Buy Kernel for Macintosh? 

You can buy Kernel for Macintosh online at https://www.nucleustechnologies.com/Buy-Macintosh-
Data-Recovery-Software.php 

I have lost my full version for Kernel for Macintosh. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

http://www.nucleustechnologies.com/Macintosh-Data-Recovery-Software.html
https://www.nucleustechnologies.com/Buy-Macintosh-Data-Recovery-Software.php
https://www.nucleustechnologies.com/Buy-Macintosh-Data-Recovery-Software.php
mailto:sales@nucleustechnologies.com
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9. Legal Notices

This section comprises the legal specification about Kernel for Macintosh and the company 
KernelApps Private Limited

9.1 Copyright 

KernelApps Private Limited, KernelApps accompanied user manual and documentation are copyright of
KernelApps Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot
be reproduced in any form without the prior written permission of KernelApps Private Limited. No
Patent Liability is assumed, however, with respect to the use of the information contained herein. 

© KernelApps Private Limited. All rights reserved.

9.2 Trademark 

KernelApps ® is a copyright work of KernelApps Private Limited.

Windows' 95®, Windows' 98®, Windows' ME®, Windows' NT®, Windows' 2000 Server®, Windows' 2000 
Advanced Server®, Windows' 2003 Server®, Windows' XP®, Windows Vista and MS-DOS are registered 
trademarks of Microsoft Corporation. 

Mac OS X, Macintosh & Mac are registered trademarks of Apple Computers Inc. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

9.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is 
subject to change without notice. KernelApps Private Limited provides no warranty with regard to this
manual or any other information contained herein and here by expressly disclaims any implied warranties 
of merchantability or fitness for any particular purpose with regard to any of the foregoing KernelApps 
Private Limited assumes no liability for any damages incurred directly or indirectly from any technical or
typographical errors or omissions contained herein or for discrepancies between the product and the 
manual. In no event shall KernelApps Private Limited, be liable for any incidental, consequential special,
or exemplary damages, whether based on tort, contract or otherwise, arising out of or in connection with 
this manual or any other information contained herein or the use there of. 

9.4 License Agreement 

KernelApps Macintosh License Agreement

KernelApps Macintosh Copyright © by KernelApps Private Limited. All Rights Reserved.

Your Agreement to this License 
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You should carefully read the following terms and conditions before using, installing or distributing 
this software, unless you have a different license agreement signed by KernelApps Private Limited.

If you do not agree to all of the terms and conditions of this License, then: do not copy, install, distribute 
or use any copy of KernelApps Macintosh with which this License is included.

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 
KernelApps Macintosh. For purposes of this License, if you have a valid single-copy license, you have the
right to use a single Licensed Copy of KernelApps Macintosh; if you or your organization has a valid
multi-user license, then you or your organization have - has the right to use up to a number of 
Licensed Copies of KernelApps Macintosh equal to the number of copies indicated in the documents
issued by KernelApps Private Limited when granting the license.

Scope of License 

Each Licensed Copy of KernelApps Macintosh may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. This 
is not a concurrent user license. 

KernelApps Private Limited entirely and exclusively reserves to and all rights of any kind in KernelApps
Macintosh, which are not expressly granted in this License. You may not rent, lease, modify, translate, 
reverse engineer, recompile, disassemble, or create derivative works based on, KernelApps Macintosh,
nor permit anyone else to do so. You may not make access to KernelApps Macintosh available to
others in connection with a service bureau, application service provider, or similar business, nor permit 
anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

KernelApps Macintosh, and any and all accompanying software, files, data and materials, are
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. 
In particular, there is no warranty for the quality of data recovered. You acknowledge that good 
data processing procedure dictates that any program, including KernelApps Macintosh, must be
thoroughly tested with non-critical data before there is any reliance on it, and you hereby assume the 
entire risk of all use of the copies of KernelApps Macintosh covered by this License. This disclaimer
of warranty constitutes an essential part of this License. 

In addition, in no event does KernelApps Private Limited authorize you or anyone else to use
KernelApps Macintosh in applications or systems where KernelApps Macintosh's failure to perform
can reasonably be expected to result in a significant physical injury, or in loss of life. Any such use 
is entirely at your own risk, and you agree to hold KernelApps Private Limited harmless from
any and all claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, 
and merges and supersedes all other or prior understandings, purchase orders, agreements 
and arrangements. The laws of the State of Delhi shall govern this License. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and foray located in the State of Delhi, 
and you 
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consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, obligations 
or representations made by KernelApps Private Limited herein. Any waiver by KernelApps Private 
Limited of any violation of this License by you shall not constitute, nor contribute to, a waiver by
KernelApps Private Limited of any other or future violation of the same provision, or any other provision,
of this License. 




